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Prayer takes place in St Bartholomew’s 
every Monday at 9am (excluding bank holidays)

	 SATURDAY 2 DEC	 CHRISTMAS TREE LIGHTING
		  5.00 pm	 Bonners Nativity
		  5.45 pm 	 Tree Lighting
		  6.00 pm	 Santa and refreshments

	 SUNDAY 3 DEC	 ADVENT SUNDAY
		  11.15 am	 All-Age Worship 

	 SUNDAY 10 DEC	 11.15 am	 Morning Worship
		  4.00 pm	 Carol Service

	THURSDAY 14 DEC	 10.00 am	 Midweek Communion

	 SUNDAY 17 DEC	 11.15 am	 Holy Communion

	 SUNDAY 24 DEC	 CHRISTMAS EVE
		  11.15 am	 All-Age Worship
		  11.00 pm	Midnight Service

	 MONDAY 25 DEC	 CHRISTMAS DAY
		  10.45 am	 Christmas Service

	THURSDAY 28 DEC	 10.00 am	 Midweek Communion

	 SUNDAY 31 DEC	 10.30 am	 Joint All-Age 
			   Communion in Nutley
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The Rector writes

What brings you joy in the world?  At the moment, it’s 
the sparkly new supermarket, with its neon lights shining 
through the drizzle, that seems to be an eager talking point. Or perhaps it’s the 
build up to Christmas time spent with family and friends – our minds running 
forward to Christmas trees, wrapping paper, mulled wine and pigs-in-blankets.
But of course, these things, good as they are, only shine so brightly and provide 
only a temporary burst of happy adrenaline. The thing that brings joy to one 
person, may not bring joy to the other. We live in a world that continues to remind 
us that it is broken. Problems raise their head time and time again, on a global and 
personal level.
Over the past 2,000 years, there has been a joy-bringing hope that has shone 
resolutely in the darkness. Something that brings joy in the sense that, while 
not always guaranteeing happiness, provides a deep sense of hopefulness and 
optimism in an often difficult world. And this hope is something for every person.
In the Bible’s Christmas story, an event grounded in history, we meet varied people, 
men, women, young, old, locals and travellers from afar, who put their hope in 
God and found joy in his saviour, Jesus. They were individuals who discovered 
they did not hope in vain.  
The promises surrounding Jesus’ birth reveal that he is hope in a world that so 
often feels dark. Hope in a world where it often feels like the same old problems 
are continuously resurrected.  
Zechariah was the father of John the Baptist, who helped prepare people for what 
God was doing through Jesus. He said:
“And you, my child, will be called a prophet of the Most High;
    for you will go on before the Lord to prepare the way for him,
 to give his people the knowledge of salvation
    through the forgiveness of their sins,
 because of the tender mercy of our God,
    by which the rising sun will come to us from heaven
 to shine on those living in darkness
    and in the shadow of death,
 to guide our feet into the path of peace.”
Christ is likened to a rising sun that dispels the darkness and marks a new 
beginning.  Of course, Jesus quite literally rose as he rose from the dead and it’s 
this resurrection that brings with it the hope that Jesus promised, of him one 
day bringing his people into a new world where the older order of pain, sadness, 
brokenness and frustration will end. He is the one who guides our feet into the 
path of peace. 

God bless, Revd Ben

Service
Straight Half Mile,
Maresfield, TN22 3DN
01825 713600

bluauto. why go anywhere else?

Sales
Ringles Cross,
Uckfield, TN22 1HE
01825 716222

Servicing

Tyres

Brakes

Suspension

MOT

Video
Inspections

Courtesy Car

Free Wifi

Collection
& Delivery

Service

• Full Service from £149

• Interim Service from £99

• MOT’s only £29 when booked with a service

• Air Conditioning Service from £59 

• FREE Health Checks

• All Major Branded Tyres to suit all budgets

Why trust your car
anywhere else?

Book online at www.bluauto.co.uk

Spread the cost of routine maintenance
with a Monthly Service Plan from just

£19 Per Month
Brakes

Suspension

Spread the cost of routine maintenance

FANTASTIC
SERVICE

Very helpful and friendly
sta�, if I could give
more than 5 stars

I would.

60 cars in stock at our Retail Centre
in Uckfield or visit www.bluauto.co.uk
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Join us once a month on a Saturday morning for Dads and Tots. This group is 
for Dads/Grandads and their children/grandchildren aged 0-4 years of age. 

Dads and Tots is an opportunity to spend time with your children, get to know 
other dads and enjoy unlimited coffee/tea and some breakfast. 

Sessions run from 9-10:30am on a Saturday morning in St Bartholomew’s.
	 Next sessions: 	 16 December	 27 January

We ask for a donation of £2 per adult and 50p per child.
To find out more, please contact our Vicar, Ben (see page 3 for details).

Maresfield Lunch Club 
We are very sorry, but the Christmas Lunch

on 7th December is fully booked.

The next Lunch will be on Thursday 4th January 2024 
at 12.30pm in the Village Hall  

and we look forward to seeing you there.
As usual, please ring Pat on 01825 769644 or

email plangridge69@gmail.com to book your place.

We wish you all a Merry Christmas 
and a happy and healthy New Year
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Have you been sent a form to complete and wondered whether there was an 
easier way way to get this done? Needed to sign something and email it back?  
For this and more, let’s take a look at the surprising powerful Preview that comes 
bundled with your Mac.
Billed as a simple utility for displaying images and reading PDFs (those uneditable 
files often used for forms), Preview is one of the programs that I miss most when 
forced to work on a Windows machine.  
Opening an image using Preview is great right from the start because of the 
large range of image types that it recognises. Then you will find that Preview’s 
Tools menu has a number of powerful features for adjusting images. So whether 
you want to rotate the image, change its size, play around with the colour, or 
auto-enhance, these are instantly done. You can even add text or some fancy 
graphics. If you are feeling a bit techy, Preview will happily convert to other image 
types. All very handy but it is in the PDF-mangling side that it comes into its own…
The thing about PDFs is that they are usually intended to be read-only. On a 
Windows machine, you need extra software for a whole range of PDF-related 
activities. And the free versions usually stop short of a range of useful features 
such as encrypting sensitive PDFs, adding or removing pages or redacting 
information. Here is how Preview handles these in a gracefully generous manner.
In the Tools menu, you will find the ‘annotate’ section which contains an array 
of useful features. You can highlight 
text, strike it through, add notes and any 
colour of loupe that your heart desires. 
These are saved in the file and ready for 
later review or sharing. At the bottom of 
the ‘annotate’ section is the ‘signature’ 
section. This is where you can scan 
in a copy of your signature using your 
camera and then apply it to forms.
When you receive a form by email, the urge to print it, complete by hand and 
then scan it back into the computer can be almost overwhelming, as well as 
laborious. Instead, Preview enables you to add text to each section and slap on 
your signature. This makes light work of the most tedious boxed form – and the 
feeling of glorious technical wizardry is almost heady.
Among the many remaining features, a couple stand out. The first is redacting 
information. On the Tools menu you will find ‘redact’. Click it and whatever 
you select in the document will be eliminated, never to return. The second is 
encryption: pop into the ‘File’ menu and select ‘Edit Permissions’. Here you can 
set a password required to open the file which conveniently secures it.

In praise of Preview

Finally, there is adding and removing pages.  For this you need to pop over to the 
‘View’ menu and select ‘thumbnails’.  On the left you will now see the pages of the 
document. You can drag them into any order you fancy. Similarly, select a page 
and press delete and… it is gone. Or you can drag images or pages from other 
PDFs into the thumbnails and they will stay in your document. If only Windows 
came with such useful software built-in…

Roger Lyon 
rlcomputersolutions.co.uk

Dave Walker

For more of Dave’s cartoons, see www.cartoonchurch.com



10 11

Maresfield Conservation Group

Christmas is coming – yes, it does seem to be earlier and earlier each year! By the 
time you read this, hopefully the traditional Christmas tree will be in place and 
everyone will be gearing up to an enjoyable festive season. If your edition of the 
Parish Magazine arrives with you before 2nd December, then please come along 
and join us at the entrance to Maresfield Park.
Looking further ahead, we are pleased to announce an exciting initiative being 
launched in the New Year: a photographic competition. The twelve successful 
photographs, one for each month of the year, will be used to create a Maresfield 
Calendar for 2025. The competition rules can be found on our website. We 
already have our expert judge in place, so get snapping and, if all goes well, your 
photo may be selected. The calendar will be published towards the end of 2024, 
so that’s a few Christmas presents sorted for next year already!
A few developments regarding the MCG to note, the first is that from 1st January 
2024 annual subscriptions will now only be via direct debit. 
The second is that we will soon be having a vacancy on the committee, so if you 
are interested in joining us and having a greater say in how we try and protect our 
village way of life, then this could be the opportunity you may have been looking 
for.
The Winter newsletter is currently at the printers, so look out for that in the 
coming weeks.
All that remains to say is thank you for ongoing support throughout 2023 and, 
along with everyone on the MCG committee, I wish you all an enjoyable and 
peaceful festive season.

Footpaths Group
Despite the awful weather we have been managing to get out. This time of year 
leaves on the pavements are our biggest headache. We have just spent a morning 
up at BluAuto and have a number of other pavements in our leaf-blower’s sights! 
This bad weather with its high winds has caused a number of trees to come down. 
We have identified one in the woods next to the bypass, if you know of any others 
please do get in touch and we will see what we can do.

 Jo Lawrance - Chairman, MCG
Tel: 07595 914701 or 01825 278332

Email: maresfieldconservation@gmail.com
Registered Charity No: 1104136 	 Website: maresfieldconservationgroup.org

Fully insured work to BS3998

rossgreenwood1981@hotmail.co.uk

Tel: 01825 769681  Mob. 07869 270353

Hedge Cutting
Garden Maintenance
Firewood and Woodchip

Felling
Pruning
Planting

Stump Removal

• 
• 
• 
• 
• 
• 
•

Maresfield Chiropractic Clinic
PATRICK LAYEN DC. MMCA.

Registered McTimoney Chiropractor
Gentle effective treatment of back, neck and shoulder pain, sciatica 

and general sports injuries, using chiropractic technique and massage.
Day and evening appointments.

01825 761768  www.maresfieldchiropractic.co.uk
General Chiropractic Council Reg. No. 00446

Trojan Fencing Ltd
Fencing, Repairs & Replacements

All Aspects of Tree Surgery
Hedge & Grass Cutting

Stump Grinding
trojanfencing@gmail.com

01825 740385 / 07738 627246

mailto:maresfieldconservation@gmail.com
mailto:rossgreenwood1981@hotmail.co.uk
www.maresfieldchiropractic.co.uk
mailto:trojanfencing@gmail.com
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KB Executive Chauffeurs
Travel in comfort and arrive in style

•	Airport and cruise  
transfers

•	Executive travel

•	Theatres and concerts

07768 320084

•	Prom nights  
and christenings

•	Special occasions

•	Eurostar

Contact us now for  
a no-obligation quote

www.kbexec.co.uk
info@kbexec.co.uk

Paracise is a low impact exercise to 
music class that is gentle on the joints 
yet effective. Paracise flows smoothly 
through movements designed to improve 
posture, balance, mobility and flexibility, 
whilst improving your muscle memory.
Fabulous music and innovative 
choreography leave you feeling 
refreshed and invigorated.
45 minutes and no floor work.

Grow young with Paracise

Classes at
Maresfield Village Hall
Every Monday at 10am

£6.00 per class
YOUR FIRST CLASS IS  
FREE OF CHARGE.

NO NEED TO BOOK.

www.paracise.com

www.pmfservices.co.uk
************

Pressure washing
Driveway and patio cleaning

Solar panel cleaning
************

Call today for your free quote
07872 170586

or email pm_french85@live.co.uk
Visit our website for more information  

or find us on Facebook.

The Arts Society Ashdown Forest

Crowborough Community Centre, Pine Grove, Crowborough TN6 1FE
Thursday 14 December at 2pm
Searching for Shakespeare
Lecturer: Jane Tapley
After more than 400 years, William Shakespeare 
remains the most admired playwright and indeed 
the most famous Englishman in the world. In this 
talk, we explore his life, the influences on him of the 
Elizabethan age and how his work had an impact on 
the global stage. We learn what the first open-air 
theatres were like, the popularity of his plays with 
contemporary audiences, how his plays survived 
and who it was who saved them.
Jane Tapley is currently Special Events Organiser at the Theatre Royal Bath. She 
lectures regularly to theatre-going societies, the National Trust and other arts 
societies and is a researcher and consultant for theatre and TV productions..
Members free, £7 for visitors – who are very welcome. 
Refreshments available at the end of the lecture. 
For further information, contact our Membership 
Secretary on 01892 861015.  www.tasaf.org.uk

Image: Wikimedia Commons

Uckfield Folk Club
Upstairs at The Station Pub, Uckfield
Every third Tuesday of the month, at 8pm

Tuesday 19 December 
CHRISTMAS PARTY SINGAROUND

All singers and musicians welcome – floor spots available, to be arranged on 
the night, or just come and listen! Lots of space for social distancing.
Hat collection on guest nights – a contribution of £10 is suggested. 

Info: contact Pat on 07788 994266 or plangridge69@gmail.com
NB: There is a parking charge in the Station Car Park, 
but free parking is available within walking distance

www.kbexec.co.uk
mailto:info@kbexec.co.uk
www.paracise.com
www.pmfservices.co.uk
mailto:pm_french85@live.co.uk
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County Council News

Gatwick
Here are some key points from East Sussex County Council’s response to the 
Gatwick expansion proposal.
1.	 If the application is approved, there will be a need for the timely delivery 
of supporting infrastructure in advance of the Northern Runway being in full 
operation.
2.	 There is insufficient mitigation proposed to encourage a substantial shift 
towards sustainable travel to and from an expanded airport.
3.	 Gatwick Airport limited (GAL) needs to mitigate the impacts of the approaching 
traffic from the surrounding road network, including routes in East Sussex such 
as the A22 and A264, which feed into the A23/M23 corridor. GAL must also 
assess the impacts of airport growth on the strategic road network (e.g. M25) 
and ESCC’s highway network beyond the immediate environment of the airport.
4.	 ESCC requires measures that reduce traffic through sensitive locations near 
and through Ashdown Forest Special Area of Conservation (SAC) / Special 
Protection Area (SPA) and along the A22. 
5.	 It is necessary to ensure that rail infrastructure and service provision has been 
properly considered by GAL and Network Rail and can accommodate the increase 
in demand and capacity that will arise should the Northern Runway go ahead. 
This must be considered alongside wider demands for rail travel.
6.	 The proposed new coach route to/from the airport to Uckfield would only have 
a two-hourly frequency off-peak, though hourly at peak time. ESCC requests a 
regular hourly service. 
7.	 There is a need for assurances on the accuracy and reliability of the estimated 
overflight mapping and we will require East Sussex to be included as part of this 
assessment.
8.	 Night flights will need to be restricted/capped, and the Northern Runway 
should not operate between the hours of 23:00 and 06:00.
9.	 We need to know the impact of noise on Ashdown Forest, a noise-sensitive 
area.

Roads
Repairs to Church Street in Fletching are programmed for January 2024. Ruston 
Bridge Road is in the programme and I have queried why the two could not be 
done together. Equally, more patching on High St Maresfield is planned soon and 
I can’t understand why these are not done consecutively.

Whilst our local campaign for a 30mph limit in Piltdown was not successful, some 
safety improvements are promised:
•	 Improvements to the existing speed limit terminal signs
•	 Installation of new village name plates
•	 Refresh of ‘40mph’ roundels 
•	 Refresh of warning signs
•	 Refresh of road markings
•	 Installation of red surfacing at the gateways.
It is anticipated that the above scheme will be completed by winter 2024. 

Council Tax
The process for setting Council Tax for next year and the Financial Plan for the next 
5 years has begun. The County Council is carrying out an extensive consultation 
and if you have any views you wish to record, please visit https://consultation.
eastsussex.gov.uk/governance-and-community-services/budget-and-priori-
ties-for-east-sussex

Roy Galley
cllr.roy.galley@eastsussex.gov.uk  01825 713018

CHRISTINGLE WEDNESDAY 20 DECEMBER
Our well-stocked kitchen is manned by a friendly 
and helpful volunteer team. We have a carpeted 
kids’ zone with plenty of toys and arts and crafts for 
children to play safely.
St.Bartholomew’s is also an agency for Uckfield 
Foodbank and we can issue vouchers during Cafe 
hours. Please ask Angie if you need a voucher.
We run Bitesize training sessions at the Cafe, plus 
special events: Ukrainian egg painting, Christingle 
oranges, children’s short films, Christmas crafts etc 
– and we welcome other ideas.

Come and join us!

St. Barts Community Cafe
Open every Wednesday 9am-12noon

https://consultation.eastsussex.gov.uk/governance-and-community-services/budget-and-priorities-for-east-sussex
https://consultation.eastsussex.gov.uk/governance-and-community-services/budget-and-priorities-for-east-sussex
https://consultation.eastsussex.gov.uk/governance-and-community-services/budget-and-priorities-for-east-sussex
St.Bartholomew
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Parish Council News
Finance
The Parish Council is setting a budget for the next financial year (2024/25) and 
this expenditure becomes the basis of the Parish Precept part of your annual 
Council Tax Bill. The budget setting process commenced at the October meeting 
of the Finance and Administration Committee and will culminate in the Parish 
Council approving the Budget and Precept proposals at its meeting on December 
19th. All Parish Council and Committee meetings are open to the public and start 
with an allocated time for members of the public to raise issues and ask questions. 
Please contact the Parish Clerk for an invitation. 

Maresfield Lawn Bowls Club
Sadly, the Maresfield Lawn Bowls Club has closed due to a lack of support, and 
possession of its pavilion transferred to the Parish Council at the end of October. 
Consequently, a new use for this building, situated in the southeast corner of the 
Recreation Ground, needs to be found. My personal view is that it could become 
a youth club, but that would require local volunteers willing and able to run such a 
facility. If you agree with this suggestion and/or are willing to assist, or should you 
have other ideas as to the building’s future use, please contact the Parish Clerk.

Wealden Local Plan
The latest news from Wealden District Council about its forthcoming Local 
Plan is that a draft will be considered by the full Council in early February and, 
if approved, will be published for formal consultation to take place in the weeks 
following. However, there are still uncertainties surrounding possible changes to 
government planning policies, and further delays in Wealden producing its draft 
Local Plan are not inconceivable.

Parish Office Staffing
We are very pleased to welcome Nutley resident Liz Mitchell to the Parish Office 
as part time Clerical Assistant where she will be helping our Parish Clerk, Nancy 
O’Hanlon, with a whole range of administrative tasks. Rosie Barnes completes 
the team as our part time Planning Clerk. Parish office visiting hours are 10.30 to 
12.30 Monday to Friday by prior appointment, please. (E-mail clerk@maresfield-
parish.org.uk or phone 714555.)

Website
Please do log on to our Parish Website http://www.maresfieldparish.org.uk/ to 
keep abreast of Parish Council activity.  We would welcome your feedback as we 
are aiming to make the Website a really useful resource for Parish (not just Parish 
Council) information. Let us know what additional information it should contain.

Continued on page 19 
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MARESFIELD VILLAGE HALL
Available for Hire for: Meetings, Birthday Parties, 

Receptions, Keep Fit, Badminton, Groups etc
Well-equipped kitchen. Tables/chairs to seat 100.

For further details and bookings, please call: 07876 718955
or email: maresfieldvillagehall@gmail.com

Continued from page 17 

Useful links
https://my.wealden.gov.uk/		  http://www.uckfieldtc.gov.uk/
http://www.maresfieldparish.org.uk/    https://www.ashdownforest.org/ 
And you can also follow the Parish Council on Twitter and Facebook.

May I take this opportunity, on behalf of our Parish Councillors, our Clerk and her 
team, to wish all our residents a Very Happy Christmas and a Peaceful and Safe 
New Year. 

Martin Craddock 
Chairman, Maresfield Parish Council

Parish Council Meetings: December 2023

All meetings commence 7.30 pm.
Tuesday 5 Dec	 Finance & Admin Meeting (Parish Office)
Thursday 6 Dec	 NDP Steering Group (Parish Office) 
Monday 11 Dec	 Planning Meeting (Fairwarp Village Hall)
Tuesday 12 Dec	 Environment Meeting (venue TBA) – if necessary
Tuesday 19 Dec	 Full Council (Fairwarp Village Hall)

NB: Please note that meeting dates are subject to change. Please check on the 
Parish website or call the office beforehand if you are interested in attending.

–

Little Deers Playgroup
The playgroup meets in Maresfield Village Hall from 9.15 to 11am 
on Thursday mornings (except the first Thursday in the month). They 
have places for pre-school children.

Just turn up and enjoy meeting other parents 
while your children make new friends 
and enjoy playtime together, in a safe 
environment with lots of lovely toys.

mailto:maresfieldvillagehall@gmail.com
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I’m sure you’ll agree that these are crazy times, folks. Back in Ancient Rome they 
had a festival – Saturnalia – which saw their society turn upside down for a week 
each December. It seems Saturnalia’s traditions of chaos and mayhem are now 
the daily norm for us Brits but, as we career towards Christmas, we have another 
thing in common with it. We will soon be paying our respects to the holly tree. 

Holly has been celebrated in many traditions 
over the centuries because, as a native 
evergreen, its vibrancy in the dead of winter 
could easily be mistaken for immortality. Holly 
was the sacred tree of Saturn, the Roman god 
of agriculture. In pagan tradition, the Holly 
King ruled over the Oak King from midsummer 
to midwinter. Holly was easily adopted by 
Christians, who saw many links between the 
tree and the life of Christ. Today, holly remains 
a centrepiece of our Christmas decorations, 
cards and cakes. 
Each holly tree is either male or female. While 

both produce delicate white flowers in May, it’s only the female holly that bears a 
berry as red as any blood. When these berries are produced in profusion, it’s taken 
to be a sign of an oncoming hard winter -although in reality it’s the outcome of a 
successful spring. Holly’s prickles provide protection for nesting birds, their flower 
buds are food for the 
Holly Blue butterfly’s 
caterpillar and their ripe 
berries are essential for 
thrushes.
If you’re after a tree 
filled with folklore then 
holly must take a bow. 
So if you’re planning 
to deck your halls with 
boughs of the stuff 
this Christmas, here’s a 
quick user guide. First 
off, never cut down 
a holly tree – that’s 
guaranteed bad luck, a 
superstition which has 
spared many holly trees 

Holly

Image: Alan Price

from the woodsman’s 
axe. And make sure you 
leave holly trees in your 
hedgerows to prevent 
witches from running 
along the top. If you bring 
holly into your home 
at Christmas, it’ll help 
protect you from those 
pesky festive faeries. Only 
female holly leaves under 
your pillow will allow you 
to predict your future in 
your dreams. Oh, and don’t forget to get rid of your holly decorations before 
Twelfth Night (but don’t burn them, that’s bad luck too). 
Holly trees will protect you against lightning strikes (I’m not sure if this has been 
scientifically proven so don’t blame me if you still get zapped). And don’t eat the 
berries, they’re poisonous, but if you have smallpox you can drink an infusion 
made from the leaves. 
Stick to those rules folks and you’ll have a peaceful Christmas. Me? I’ve had 
enough of the state of the world today. I’m going to pour some wine, put on my 
toga and pretend I’m in ancient Rome. Somebody pass me my fiddle.

Michael Blencowe
Learning & Engagement Officer, Sussex Wildlife Trust

www.sussexwildlifetrust.org.uk
Sussex Wildlife Trust is a conservation charity for everyone who cares about nature in 
Sussex. Founded in 1961, we have worked with local people for over half a century to 
make Sussex richer in wildlife. Please consider joining us. Your membership will help us 
challenge decisions that threaten wildlife, care for more than 30 nature reserves, and 
inspire the next generation about the wonders of the natural world. It’s easy to join 
online at sussexwildlifetrust.org.uk/join

Image: Roger Wilmshurst

Prayerwaves
A weekly email with Scripture readings, prayers and prayer requests  
for those in our villages or known to us personally who are in need. 

If you would like to receive this email, please contact Ben at  
vicar.maresfieldandnutley.protonmail.com

http://www.sussexwildlifetrust.org.uk
vicar.maresfieldandnutley.protonmail.com
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Established in 1986 – still offering the best vehicle solutions
•	 MOT Testing Station
•	 Vehicle servicing and repairs for all vehicles
•	 Air conditioning services and re-gassing
•	 All brake and suspension work including ABS Systems
•	 Computer diagnostics and service indicator resetting
•	 Tyres - puncture repairs and replacements and wheel alignment
•	 Batteries and exhausts
•	 Welding, fabrication, anti-corrosion and underseal treatments
•	 Bodywork repairs, detailing, valeting and much more

High Street, Nutley TN22 3LP  Tel: 01825 712382

www.nutleymotorservices.com

     

Mike O’Donovan
Home & Garden Property Services

Pruning • Weeding • Lawns • Hedges • Decorating 
Guttering • Tiling • Woodwork • Repairs

Call: 07971 533749 or email: maod1965@gmail.com


